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Overview
Overview

The Field Guide is designed to be used as a quick
reference for experienced users of ProSystem fx®

Engagement. This Field Guide is ideal to use as a
supplement to our training courses. It describes the
most common way to perform tasks.

Refer to the ProSystem fx Engagement User Guide
for a more comprehensive explanation of these
functions and all of the ways to perform them. You
can access the User Guide from the Help Menu in
ProSystem fx Engagement.
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Local File Room
Local File R oom

There are two views for the local file room: Client
Index view and Engagement Today view.

Client Index View

1. Client Index Pane. This area of the File Room
displays client folder information. The Client Folders
hold your Engagement binders.

2. Contents Pane. This area displays the contents of
the selected item in the Client Index Pane. These
could be client folders or binders. You can sort items
shown in this pane by clicking the column headers.
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Local File Room

3. Remote File Rooms Pane. This area contains
three tabs:

CFR (Central File Room). Lists all CFRs set up
for the firm. If you have logged in from the
Field, you will not see the CFR tab.
Staff. Lists all staff members.
Buddy List. Lists the staff members you have
added to your Buddy List.

Engagement Today View

Engagement Today displays user-level diagnostic
information that summarizes key statistics regarding
the binders in your local file room. Engagement
Today also displays the Tip of the Day.

Note: Engagement Today is not available from a
shared file room.
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Local File Room

The Engagement Today view displays five panes:

1. My Recent Binders. Displays links to the last four
binders used.

2. By Lead Partner. Displays a list of binder links
sorted by lead partner from the binder properties.

3. Other Highlights. Displays a list of binder links
sorted by specific criteria.

4. By Engagement Type. Displays a list of binder
links sorted by the categories listed.

5. Tip of the Day. Displays suggestions for using the
program more efficiently. You can hide the Tip of
the Day by clicking Hide Tips. Click Previous and
Next to navigate through the tips.
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Binder Window
B inder Window

To open a binder, double-click the binder in the file
room. The Binder window is made up of four views:

Binder View
Notes Summary View
Sign Off Summary View
Current Editor View (or Live Editor View)

Binder View

The Binder View displays the contents of the binder
and the status of the workpapers in the binder.
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Binder Window

1. Shortcut Bar. The Shortcut Bar provides quick
access to many Engagement functions, including
Workpapers, the Binder Snapshot, the Trial Balance
Snapshot, the Knowledge Coach Web Site, and
Capital Confirmation electronic audit confirmation
service. If ProSystem fx Suite is installed, a shortcut
to the Dashboard is also available.

2. Binder Index Pane. The Binder Index Pane
includes the following folders:

Binder. The Binder name displays beside one
of the following images, based on the
Document Completion Date:

Icon Name/Description
Standard binder. The user is
not the current editor of any
workpapers in the binder, and
the document completion date
is not approaching or past due.
Current Editor. The user is
the current editor of at least
one workpaper in the binder,
and the document completion
date is not approaching or past
due.
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Binder Window

Icon Name/Description
Document Completion Date
Approaching. The user is not
the current editor of any
workpapers in the binder, and
the document completion date
is within the specified number
of days (i.e., 45 or 60 days)
from the current date.
Document Completion Date
Approaching and Current
Editor. The user is the current
editor of at least one
workpaper in the binder, and
the document completion date
is within the specified number
of days (i.e., 45 or 60 days)
from the current date.
Document Completion Date
Past Due. The user is not the
current editor of any
workpapers in the binder, and
the document completion date
set for the binder is past due,
so all changes made the binder
must be documented.
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Binder Window

Icon Name/Description
Document Completion Date
Past Due and Current Editor.
The user is the current editor
of at least one workpaper in
the binder, and the document
completion date set for the
binder is past due, so all
changes made the binder must
be documented.
Finalized Binder. The binder
has been finalized.
Finalized Binder Partially
Synchronized. The binder has
been finalized but errors
occurred during
synchronization, or the binder
synchronization was stopped
by the user and is only
partially synchronized.

Note: If you are Current Editor of a
binder, a current editor designation arrow
displays on top of the appropriate binder
icon above.
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Binder Window

Unfiled Workpapers. This folder stores
workpapers that have not been filed yet.
Reports generated by ProSystem fx Engagement
originally appear here. You can then move
each report to the desired workpaper tab
section.
Conflicts. This folder stores workpapers in
conflict after synchronization or from binder
packages that have been received.
Incompatible Workpapers. This folder
displays if you have Knowledge Coach
installed. It stores Knowledge Coach
workpapers that could not be filed in the active
binder because the title version of the
workpaper is not compatible with the title
version of the binder.
Published Workpapers. This folder stores
copies of Word or Excel workpapers where the
formulas (such as, trial balance links) have
been automatically converted to values.
Trash. This folder contains the workpapers you
delete in ProSystem fx Engagement. If you
have deleted a workpaper by mistake, you can
restore it and it will be filed back to the
appropriate tab.

The Binder folder contains tabs that organize the
workpapers. Workpaper properties display in columns
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Binder Window

to the right of the Binder Index column and include
the following:

Index Number and Name. The alphanumerical
index number is optional. The name is
required, and it describes the content of the
workpaper.
Locked. A locked paper is read-only.
Frozen Links. If the Engagement links in the
selected workpaper are frozen, this icon
displays.
Note. If a note has been created for this
workpaper or workpaper tab, this icon displays.
Modified after Reviewer Sign Off. If the
administrator has chosen to flag workpapers
that have been modified after a reviewer has
signed off, this icon displays as appropriate.
Prepared By. When a workpaper is signed off
by a preparer, the date and preparer’s initials
display.
Reviewed By. When a workpaper is signed off
by a reviewer, the date and reviewer’s initials
display.
2nd Reviewed By. When a workpaper is signed
off by a second reviewer, the date and
reviewer’s initials display.

10



Binder Window

File Modified Date. The date and time the
workpaper was last changed.
Current Editor (if viewing a non-shared file
room). The staff member who has checked out
this workpaper.
Live Editor (if viewing a shared file room).
The staff member who has this workpaper
open. If no staff member has the workpaper
open, then <Available> displays if the file
room's host is current editor of the workpaper.
<Unavailable> displays if the host is not the
current editor.
Assigned To. The team member who the
current editor has assigned the workpaper to
prior to synchronizing. (Does not display in
shared file rooms.)

3. Notes Pane. When a workpaper or tab with a
note is selected in the Binder window, information
about the following displays: subject, number of
responses, who it is from and assigned to, the date
created, who cleared the note, and the date
cleared.

Note: If Knowledge Coach is installed, a
Diagnostic pane also displays above the Notes
pane.
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Binder Window

Notes Summary View

The Notes Summary View displays all of the notes
that exist in the binder. The Notes are broken down
into three types:

Team Notes
Open Items
Notes for Next Period
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Binder Window

Sign Off Summary View

The Sign Off Summary View displays the level of
review for all of the workpapers that exist in the
binder.

The level of review is broken down into three stages:

In Process
Ready for Review
Reviewed

Team members that have signed workpapers off are
listed, with the sign off date, under each workpaper.
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Binder Window

Current Editor View (or Live Editor View)

If you are viewing a non-shared local file room, the
Current Editor View tab is available. The Current
Editor View displays all of the team members
assigned to the binder. Displayed under each team
member is a list of the workpapers they have
checked out. Any workpaper not checked out to a
team member appears in the Unassigned section.

If you are viewing a shared local file room, the Live
Editor View tab is available. The Live Editor View
displays all the staff members who are currently
working on a workpaper in the binder. Under each
staff member is a list of the workpapers he or she is
working on. Any workpapers that are not being
worked on are listed in the Unassigned section.
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Engagement Toolbar - File Room              
Engagement T oolbar - File R oom              

The Engagement toolbar in the File Room window
consists of the following buttons:

New Client. Creates a new client
folder.

New Binder Wizard. Creates a new
binder.

Assign Binder Staff. Adds team
members to a binder.

Open. Opens the selected item.

Open Trial Balance. Opens the trial
balance in a selected binder. If there is
more than one trial balance, a list
appears for you to select from.

Cut. Cuts item(s) to the clipboard.

Copy. Copies item(s) to the clipboard.

Paste. Pastes item(s) from the
clipboard.

Expand All. Expands the entire tree.

Collapse All. Collapses the entire tree.

Properties. Displays properties of the
selected item.
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Engagement Toolbar - File Room              

Refresh. Refreshes the local file room
or central file room.

Create Binder Package. Creates a
single file (compressed) of a binder to
send to other Engagement users.

Receive Binder Package. Receives a
binder package created by another
Engagement team member.

Synchronize Binder. Opens the
Synchronize Binder Wizard.

Express Synchronization.
Automatically synchronizes the binder to
the central file room without opening
the Synchronize Binder Wizard.

Tax Software Interface. Exports trial
balance data to tax vendors.

Finalize Binder. Opens the Finalize
Binder Wizard for the selected binder.

Roll Forward. Opens the Roll Forward
Wizard for the selected binder.

Client Inquiry. Opens the ProSystem fx
Practice Client Inquiry Module.
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Engagement Toolbar - File Room              

Engagement Today. Displays the
Engagement Today view.

Client Index. Displays the Client Index
view.

Client Group Filter. Filters the clients
in the file room by client group.
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Engagement Toolbar - Binder Window
Engagement T oolbar - B inder Window

The Engagement toolbar displayed in the Binder
window consists of the following buttons:

New Tab. Creates a new workpaper tab.

New Workpaper from Template. Creates a new
workpaper from predefined templates.

New Workpaper from File. Inserts into the
binder a new workpaper from an Excel, Word, or
other file type.

New Trial Balance. Creates a new trial balance.

New Manual Workpaper. Creates a workpaper to
serve as a placeholder for a physical workpaper
not inserted into the Binder.

New Placeholder. Creates a name and index
number for a workpaper that will be added at a
later date from a file or scanned document.

New Knowledge Coach Workpaper. Creates a
new workpaper from the Knowledge Coach
Workpaper Templates. Requires installation of
Knowledge Coach titles.

New Workpaper from Scanner. Creates a new
workpaper from a TWAIN-compliant scanner.

Open. Opens the selected item.
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Engagement Toolbar - Binder Window

Open Trial Balance. Opens the trial balance. If
there is more than one trial balance, a list
appears for you to select from.

Print. Prints the selected workpaper or report.

Cut. Cuts item(s) to the clipboard.

Copy. Copies item(s) to the clipboard.

Paste. Pastes item(s) from the clipboard.

Properties. Displays properties of the selected
item.

Expand All. Expands Binder Views to show all
workpapers.

Collapse All. Collapses Binder Views to hide all
workpapers.

Refresh. Refreshes and re-sorts Binder tabs and
workpapers.

Publish Workpaper. Publishes a workpaper to
convert formulas to values.

Lock Workpaper. Locks a workpaper as read-
only.

Unlock Workpaper. Unlocks a workpaper.
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Engagement Toolbar - Binder Window

Freeze Links. Freezes Engagement links in the
selected workpaper so that links are not
refreshed.

Unfreeze Links. Unfreezes Engagement links for
the selected workpaper.

Create Workpaper Note. Creates a note for the
selected workpaper.

Sign Off Workpaper Properties. Opens the
Workpaper Properties dialog.

Sign Off As Preparer. Adds sign off initials in the
Prepared by column.

Sign Off As 1st Reviewer. Adds sign off initials in
the Reviewed by column.

Sign Off As 2nd Reviewer. Adds sign off initials
in the 2nd Reviewed by column.

Tax Software Interface. Exports data to tax
packages.

Binder View. Displays binder contents and
workpaper status.

Notes Summary View. Displays workpaper and
workpaper tab notes by type.

Sign Off Summary View. Displays workpapers
sorted by level of review.
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Engagement Toolbar - Binder Window

Current Editor View/Live Editor View. Displays
workpapers sorted by current editor or live editor.
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Engagement Toolbars in Excel and Word
Engagement T oolbars in Excel and Word

Engagement with the Microsoft Office Ribbon

Engagement takes advantage of the Ribbon interface
in Excel and Word. The Engagement tab displays all
of the functions you need to complete workpaper
tasks. The Workflow group of the Engagement tab
includes the six most recently used tickmarks.

Engagement Ribbon – Excel

The Microsoft Excel Ribbon consists of the following
buttons:

QuickView. Displays the balance
broken down by assets, liabilities and
equity, revenue, expenses, and net
income.

Refresh. Refreshes all links in the
workpaper, including Name, Date, and
Trial Balance Links.

Properties. Enables you to view and
modify trial balance and trial balance
report properties.
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Engagement Toolbars in Excel and Word

Copy TB Link. Links data from your
trial balance to your workpapers or
financials. This information updates
with trial balance changes.

Quiklink. Links between a trial
balance and the ProSystem fx Tax
return.

Create WP Note. Creates a note for
the workpaper.

Insert WP Reference. Inserts a
reference link to another workpaper in
the binder.

Open WP Reference. Opens the
referenced workpaper.

Add Journal Entry. Adds a journal
entry.

JE Summary. Displays current journal
entries by type. You can add, modify,
or delete journal entries from this
window.

WU Journal Entry. Organizes the
transaction data in journals.
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Engagement Toolbars in Excel and Word

Chart of Accounts. Allows you to add,
modify, and delete trial balance
accounts. You can also add balances to
different columns in the trial balance.

TB Edit Mode. When toggled on,
allows you to make changes to the
trial balance directly.

Import. Assist in importing trial
balance data from other supported
trial balance software programs.

Consolidate TB. Consolidates data
from single company trial balances
into a consolidated trial balance.

Account Groupings. Opens the
Account Groupings window.

Classifications. Allows you to view
and edit account and ratio
classifications.

Funds Setup. Opens the Funds Setup
dialog where you can add, edit, or
delete funds for the selected trial
balance. This is available for fund trial
balances only.
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Engagement Toolbars in Excel and Word

Create. Create TB, Consolidated,
Journal Entry, Fund TB, Fund JE, or
Write-Up reports.

View. Switch to any view you created
in your trial balance.

Group. Switch to any grouping list you
created in your trial balance.

TB Column Setup. Opens the TB
Column Setup window where you can
modify the columns displayed in the
trial balance.

Select Funds. Displays the Select
Funds dialog where you can setup fund
types, fund subtypes, and funds and
then assign accounts directly to these
funds. This is available for fund trial
balances only.

Engagement Ribbon – Word

The Microsoft Word Ribbon consists of the following
buttons:

QuickView. Displays the balance broken
down by assets, liabilities and equity,
revenue, expenses, and net income.
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Engagement Toolbars in Excel and Word

Refresh. Refreshes all links in the
workpaper, including Name, Date, and
Trial Balance Links.

CCH Footnote. Inserts a CCH footnote.

Insert TB Link. Creates links from the
trial balance, without having to open the
trial balance.

Paste TB Link. Links data from your trial
balance to your workpapers or financials.
This information updates with trial
balance changes.

Drill-down TB Link. Drills down to the
accounts included in the linked formula.

Name Functions. Inserts Client,
Engagement, and Firm information links.

Date Functions. Inserts Current and Prior
date links.

Freeze TB Links. Freezes Engagement
links for the workpaper so that links are
not refreshed.

Replace TB Link Name. Replaces trial
balance link names and updates links.
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Engagement Toolbars in Excel and Word

View Field Codes. Toggles all links in
Word on/off. When on, you can view and
edit Engagement formula links directly.

Insert WP Reference. Inserts a link to
another workpaper in the binder.

Open WP Reference. Opens the
referenced workpaper.

Create WP Note. Creates a note for the
workpaper.

Tickmarks. Displays the tickmark toolbar.

Add Journal Entry. Adds a journal entry.

JE Summary. Enables you to add, modify,
or delete journal entries.

WU Journal Entry. Organizes the
transaction data in journals.

Setup. Access trial balance setup
functions.
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Adding Items - File Room
A dding Items - File R oom

New Client Folder

1. Click New Client on the toolbar.

2. Enter the client’s information on the Profile
tab.

3. Click the Groups tab to assign the client to a
client group.

4. Click the Contacts tab to enter contact
information.

5. Click OK when finished.

New Binder

1. Click New Binder Wizard on the toolbar.

2. Click Next on the Welcome dialog.
3. Select the client folder and click Next.
4. Select a central file room and click Next.
5. Select the source for the binder:

Create binder from template.
a. Select the tab containing the

template.
b. Select a template and click Next.

Create blank binder (no tabs or
workpapers). Click Next.
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Adding Items - File Room

Create binder from existing binder in
your local file room.

a. Select client folder that contains
the binder.

b. Select the binder to use and click
Next.

6. Enter the general properties of the binder and
click Next.

7. Enter period information for the binder and
click Next.

8. If you selected a template or existing binder
with Knowledge Coach workpapers, the
Knowledge Coach options page displays. Select
the needed options, and then click Next.

9. Assign additional teams or staff to the binder
by clicking the Assign buttons.

Note: To assign staff members after a
binder has been created, select the binder
in the File Room and then select
File/Properties. On the Binder Staff tab,
click the Assign button.

10. Click Finish.
11. Review the New Binder Summary Report and

click Create to create the binder.
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Adding Items - File Room

12. If this is a Knowledge Coach binder and you
have selected to update content, you will need
to select which title version to update to
before the new binder can be created.
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Adding Items - Binder Window
A dding Items - B inder Window

New Tab

To add a new tab, do the following:

1. In the Binder Index, right-click where you want
the new tab.

2. Select New Tab from the list.
3. Enter the Name (required) and Index #.
4. Click OK.

New Workpaper

You can add a workpaper in one of the following
ways:

New Workpaper from Template

1. Right-click the tab where you want the new
workpaper.

2. Select New Workpaper from Template.
3. Select the tab containing the template.
4. Select the template to use and click OK.
5. Enter the Name (required) and Index #.
6. Click OK.
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Adding Items - Binder Window

New Workpaper from File

1. Right-click the tab where you want the new
workpaper.

2. Select New Workpaper from File.
3. Choose the location in the Look in field.
4. Select the file to insert and click OK.
5. Enter the Name (required) and Index #.
6. Click OK.

New Trial Balance

1. Right-click the tab where you want the new
workpaper.

2. Select New Trial Balance.
3. Select the tab containing the template.
4. Select the template to use and click OK.
5. Enter the Name (required) and Index #.
6. Click OK.

New Manual Workpaper

1. Right-click the tab where you want the new
workpaper.

2. Select New Manual Workpaper.
3. Enter the Name (required) and Index #.
4. Click OK.
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Adding Items - Binder Window

New Placeholder

1. Right-click the tab where you want the new
workpaper.

2. Select New Placeholder.
3. Enter a Name (required) and Index #.
4. Click OK.

New Knowledge Coach Workpaper

1. Right-click the tab where you want the new
workpaper.

2. Select New Knowledge Coach Workpaper.
3. Select an industry.
4. Select the workpapers from the industry.
5. Click OK.
6. If needed, you can do the following for each

workpaper to be inserted:
Enter an index
Change the workpaper name
Select the roll forward options

New Workpaper from Scanner

1. Right-click the tab where you want the new
workpaper.

2. Select New Workpaper from Scanner.
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Adding Items - Binder Window

3. Select your scanner from the Scanner drop-
down menu and click Scan.

4. Adjust any settings, and begin the scan
according to your scanner's user guide.

5. Review a thumbnail image of each scanned
page and click Scan More or Finish.

6. Enter the Name (required) and Index #.
7. Click OK.
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Understanding the Trial Balance
Understanding the T rial B alance

While Trial Balances appear to be normal Excel files,
they actually represent the databases that store all
of your data. The types of trial balances are as
follows:

Standard single company trial balance

Consolidated trial balance

Fund trial balance

Write Up trial balance

Trial balances created with a version of Engagement
prior to 6.0 must be converted to Microsoft SQL
Server database files. To do this, select Start >
Programs > ProSystem fx Engagement > Utilities,
and then click ProSystem fx Engagement Trial
Balance Conversion Wizard. The wizard
instructions will guide you through the conversion
process.

If you prefer, trial balances can be converted when
binders are synchronized in ProSystem fx
Engagement.

Note: See Advanced Trial Balance Functions on
page 76 for details on creating consolidated, fund
and write up trial balances.
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Understanding the Trial Balance

Opening a Trial Balance

Click Open Trial Balance from the Binder window.
This launches Excel, allowing you to view the trial
balance.

Note: If you have more than one trial balance in
your binder, a window displays listing all trial
balances. Select the appropriate trial balance and
click OK.

Parts of a Trial Balance

There are three areas in the trial balance that allow
you to change the way information is displayed.

Changing the View. You can switch to any
view you created in your trial balance from the
View drop-down menu. The columns to the
right of the Account and Description columns
change based on your settings for that view in
the TB Column Setup. Examples of column
descriptions are Unadjusted Balance, Final
Balance, and Prior-Period Final Balance. See
Setting Up Trial Balance Views on page 39 for
further details.
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Understanding the Trial Balance

Changing the Fund View. You can modify the
views of the new fund worksheets using Select
Funds to change the columns that are displayed
by selecting the period, balance type, and
funds you want to view. You can also select to
hide fund and total columns.
Changing the Grouping List. You can switch
to any grouping list you created in your trial
balance from the Group drop-down menu.
Different groups and sub-groups display in the
Account Group Summary and Account Sub-
Group Summary tabs. See the following
section, Changing Worksheet Tabs, for details
on worksheet tabs.

The Account column displays the group or sub-
group index numbers you created. The
Description column displays the group or sub-
group descriptions you created. The Grouping
lists are created, modified, and deleted from
the Account Grouping window. See Account
Groupings on page 55 for further details.
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Understanding the Trial Balance

Changing Worksheet Tabs. You can navigate
among worksheets using the following tabs:

Account Detail. This tab displays the
trial balance by account number.
Subtotaling cannot be performed on this
worksheet. You can manually add
subtotals to TB Reports generated from
the trial balance.
Account Group Summary and Account
Sub-Group Summary. These tabs
display the totals for each group or sub-
group you created in the Account
Grouping window. Change the Grouping
List from the Group toolbar drop-down
to change which groups or sub-groups
you want displayed.
Fund Group Summary. This tab displays
groups and balances for funds and, if
selected, shows the totals for the fund
types and subtypes.
Fund Sub-Group Summary. This tab
displays the subgroups and balances for
funds and, if selected, shows the totals
for the fund types and subtypes.
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Using Trial Balance Functions
Using T rial B alance Functions

Setting Up Trial Balance Views

1. Select TB Column Setup from the Trial
Balance menu in the Binder window.

2. In the Trial Balance field, select the trial
balance with the columns you want to modify.

3. In the View field, select the view with the
column setup you want to modify. Click
Options to create a new view.

4. In the Available Columns field, select the
period that contains the columns you want to
select from. Select the available column on the
left side and then select the right-pointing
arrow to add the column to your view.

5. To add a variance column, click Add Variance
and select the appropriate information in the
Column Properties section.

6. Click Close to save your changes.
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Using Trial Balance Functions

Setting Up Fund Trial Balance Views

1. From the trial balance, click Select Funds
from the View group on the Engagement
ribbon.

2. In the Balance section, select the Period and
Balance type for the fund and total columns in
the fund worksheets of the trial balance.

3. Select the fund types, fund subtypes, and funds
in the tree control that you want to display in
the fund trial balance.

4. Select the options you would like for the fund
worksheets.

5. Select OK to close the dialog and refresh the
columns of the fund trial balance worksheet.

Converting and Importing Trial Balance Data

You can convert trial balance data from other
supported trial balance software packages into an
Engagement trial balance. You can also import trial
balance data from another Engagement trial
balance. For other cases, import the information
using the Paste TB Import function.
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Converting Trial Balance Data from ProSystem fx Write Up or
ProSystem fx Trial Balance

1. Select Import Conversion Wizard from the
Trial Balance menu in the Binder window.

2. Choose the source of your conversion file.
3. Click Next.
4. Select the ProSystem fx Engagement trial

balance you want to transfer the data into from
the Select Trial Balance drop-down list.

5. Select the ProSystem fx Trial Balance or Write-
Up file from the Select export file drop-down
list. If applicable, the default file or file
extension is displayed to assist you.

6. Select the appropriate current period
information, tax information, chart of accounts
settings, and lead classifications options, as
necessary.

7. Click Finish.

Converting Trial Balance Data from ATB for Windows, GoSystem
Audit, or an ASCII Text File

1. Select Import Conversion Wizard from the
Trial Balance menu in the Binder window.

2. Choose the source of your conversion file.
3. Click Next.
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4. Select the ProSystem fx Engagement trial
balance you want to transfer the data into from
the Select Trial Balance drop-down list.

5. Select the source file for import.
6. Select the number of prior periods.
7. If importing from an ASCII Text file, select

whether the source file is comma delimited or
tab delimited.

8. If importing from GoSystem Audit, select the
balance type to convert.

9. Click Next.
10. If importing from GoSystem Audit, do the

following:
a. Select whether to convert all groupings,

convert all and map to one Engagement
grouping, or map to one Engagement
grouping.

b. If you are mapping groupings, select the
GoSystem Audit grouping to map from on
the left, and select the ProSystem fx
Engagement grouping to map to on the
right.

c. Select the appropriate options for
converting tax codes, if necessary.

d. Click Next.
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11. On the Chart of Accounts screen, click the gray
bar at the top of each column to select the
appropriate header information. You can assign
only one trial balance column to each column
of imported data.

12. Select whether to append or overwrite the data
in the existing trial balance.

13. Select the appropriate rounding options as
necessary.

14. Click Next.
15. Click Yes.
16. Click OK to begin the conversion. The

Summary screen displays.
17. Click Finish.

43



Using Trial Balance Functions

Importing from Creative Solutions Accounting

With Creative Solutions Accounting, you can import
annual, semi-annual, quarterly, and monthly
standard balances.

Important! Weekly, 13-period, budget and other
balances, and write-up trial balances are not
supported.

To import client data from Creative Solutions
Accounting into an Engagement trial balance,
complete the following:

1. Select Import Conversion Wizard from the
Trial Balance Menu in the Binder Window.

2. Choose the source of your conversion file and
click Next.

3. From the Engagement trial balance drop-down
list, select the ProSystem fx trial balance you
want to transfer into. Engagement Consolidated
and Engagement Write-Up trial balances are
not supported.

4. Select the client file (*.wsw or *.wsz file) to
import, or click Browse to select a file.

Note: If the CSA database is password
protected, enter your password.
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5. In the Chart of accounts information section,
select whether to append or overwrite the
existing data in the Engagement trial balance
data.

6. Select the appropriate rounding options as
necessary.

7. Check the All active periods in CSA are
closed (recommended) box, if you do not
want to import current period CSA data. When
selected, the CSA balance type to import as
Engagement current unadjusted balance field
is disabled.

8. If converting CSA tax codes to Engagement tax
code assignments, select the appropriate
options in the Tax information section. Click
Next.

9. In the Account groupings section, select one of
the following:

Convert all CSA account groups and
grouping schedules
Convert all CSA groups and schedules
and map one schedule to one
Engagement grouping
Map the accounts from one CSA schedule
to one Engagement grouping
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Note: Accounts assigned to CSA account
groups will not be assigned to the groups in
the resulting Engagement grouping list
since the assignment of ranges of accounts
is not supported in Engagement. After the
import is complete, you can map the
accounts to the appropriate groups and
subgroups using the Account Grouping
option in Engagement.

10. If you are mapping a CSA grouping schedule,
first select the applicable CSA grouping
schedule and Engagement grouping list. Then,
select the CSA codes or subcodes to map from
on the left, and select the Engagement groups
or subgroups to map to on the right.

11. Click Finish.

Importing Data from CaseWare

1. Select Import Conversion Wizard from the
Trial Balance menu in the Binder window.

2. Choose the source of your conversion file and
click Next.

3. Select the ProSystem fx Engagement trial
balance you want to transfer the data into from
the Select Engagement trial balance drop-down
list.
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4. Select the client file for import.

Note: Only client files with the extension
.ac are accepted. Compressed files with
the extension .ac_ are not accepted.

5. Select the CaseWare entity.
6. In the Chart of accounts information section,

select the period sequence, the current
CaseWare period to import into Engagement,
and the CaseWare current period balance type.

7. Select whether to append to or overwrite the
existing data in the Engagement trial balance
data.

8. Select the appropriate rounding options as
necessary.

9. Select one of the following:
Convert all groupings
Convert all and map to one Engagement
grouping
Map to one Engagement grouping

10. If you are mapping groupings, select the
CaseWare grouping to map from on the left,
and select the ProSystem fx Engagement
grouping to map to on the right.

11. Click Finish.
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Importing TB Data from a QuickBooks Excel TB Report

1. Export the QuickBooks Trial Balance report to
Excel.

Note: You must select the Use account
numbers and Show lowest subaccount
only in QuickBooks.

2. Insert the QuickBooks Excel report in the
binder (optional).

3. Do one of the following:
If the Excel report is in the binder,
select Import/Import Excel QuickBooks
Data from the TB Setup lookup item on
the Engagement ribbon.
If the Excel report is not inside the
binder:

i. Open the Engagement trial
balance where the data is to be
imported.

ii. Open the QuickBooks Excel report
and select Import Excel
QuickBooks Data on the
Engagement ribbon.
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iii. Navigate to the Engagement trial
balance and click Paste TB
Import.

4. Define the columns by clicking the gray column
header bar and selecting the appropriate
column description from the menu that
appears. Do this for all columns you want to
import. Do not define the header for those you
do not want to import.

5. Do one of the following:
Select Append to add your current data
to the existing trial balance.
Select Overwrite to destroy all existing
account data and journal entries. The
accounts must be regrouped. Overwrite
also unassigns all previous group and
sub-groupings.

6. Correct duplicated account numbers, invalid
accounts, and blank fields highlighted during
import.

7. To round balances, select the place to round
the account balances to in the Round Balance
to Nearest field and complete the Select
Rounding Account field.

8. Click Next.
9. Click Yes.
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10. Click OK.
11. Review the statistical information and click

OK.

Importing TB Data From an Excel File

1. Open the trial balance.
2. Open the Excel file containing your trial

balance data.
3. Do the following to prepare the content for

import:
Organize the data so that there are no
blank rows in the data range.
Remove any of the following characters
from the account number and balance
columns: ' : " , | ( ) * ?.
Verify that the total of each balance
column nets to zero.

4. Select the range of data, excluding any column
headers or balance checks, and select Edit >
Copy in Excel.

5. Switch to the trial balance by selecting it from
the window menu in Excel.

6. Click Paste TB Import. 

7. Define the columns by clicking the gray column
header bar and selecting the appropriate
column description from the menu that
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appears. Do this for all columns you want to
import. Do not define the header for those you
do not want to import.

Important information when a fund
trial balance is selected! When a fund
trial balance is selected, the Fund Index
can be selected as a column heading or
the Fund Mask option can be defined on
the Fund Mask tab of the Funds Setup
dialog.

8. Do one of the following:
Select Append to add your current data
to the existing trial balance.
Select Overwrite to destroy all existing
account data and journal entries. The
accounts must be regrouped. Overwrite
also unassigns all previous group and
sub-groupings.

9. Correct duplicated account numbers, invalid
accounts, and blank fields highlighted during
import.

10. To round balances, select the place to round
the account balances to in the Round Balance
to Nearest field and complete the Select
Rounding Account field.

11. Click Next.
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12. Click Yes.
13. Click OK.
14. Review the statistical information and click

OK.

Importing TB Data From An Engagement Trial Balance

1. Open the trial balance to import data to.
2. Select Engagement > Import from

Engagement TB.
3. Select the client name, binder, and trial

balance from which to import. These fields are
required.

4. If necessary, check the Import current period
balance box and select the current period
balance type to import.

5. If necessary, check the Import prior period
balance box and select the prior period
balance type to import.
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6. If you checked Import current period balance,
Import prior period balance, or both, choose
whether to append or overwrite the data.

Note: If you have previously imported trial
balance data from the source trial balance,
the Import status based on last binder
synchronization section displays the date
and time of the last import, the date and
time that the source binder was last
synchronized, and the status of the source
binder.

7. Click Check for Source TB Changes to
determine whether any balance changes exist
between the source trial balance and the target
trial balance.

8. Click OK.

Checking for Changes to the Source Trial Balance

You can check for balance differences between a
source Engagement trial balance and a target
Engagement trial balance after you have imported
data from one to the other. To check for changes:

1. From the Binder window, select Trial
Balance > Check for Source TB Changes.

2. If more than one trial balance exists in the
binder, the Select Target Trial Balance dialog
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displays. Select the target trial balance and
click OK. The Import from Engagement TB Log
File displays. Only accounts with balance
differences are shown in the log file.

Note: If no differences between the source trial
balance and the target trial balance are detected,
a message displays. The log file does not display
if there are no differences.

Chart of Accounts

Use the Chart of Accounts window to add, modify,
and delete accounts.

1. Select Chart of Accounts from the Trial
Balance menu in the Binder window.

2. Select the trial balance from the Trial Balance
field.

3. Select a period and balance type from the
Period and Balance type fields.

4. Select a grouping list to display a Group and a
Subgroup column in the grid in the Grouping
list field.

5. Do any of the following as needed:
To add an account to a trial balance,
click New and enter information for
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each new account. Added accounts need
to be grouped.
To modify account information, click in
the cell you want to modify and enter
the change.
To delete an account, click the account
row and then click Delete. Deleted
accounts remove the prior year
information.

TB Edit Mode

Use TB Edit Mode to manually enter current period
balances or to modify prior period amounts.

Click TB Edit Mode when the trial balance is open
to enter information directly into the database.
Toggle this on or off by clicking the toolbar button.

Account Groupings

1. Select Account Groupings from the Trial
Balance menu in the Binder window.

2. Select the trial balance where you want to
group accounts from the Trial Balance drop-
down menu.
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3. Select the Account Grouping List you would
like to group the accounts to from the
Grouping List drop-down list.

4. Add groups or sub-groups by right-clicking in
the Groups and Sub-groups window.

Note: You may also add groups or sub-
groups by clicking Advanced below the
window.

5. Click Close when finished.
6. You can assign Account and Ratio

Classifications when editing a group or sub-
group by clicking Advanced or by assigning the
classification when the group or sub-group is
created. These classifications are used to break
down balances and calculate net income or loss
for the period. These classifications may also
be used for TB Links.

Note: If Account and Ratio Classifications
are assigned, the Quickview option displays
the balances broken down by assets,
liabilities and equity, revenue, expenses,
and net income. Select Quickview from
the Trial Balance menu in the Binder
window.
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7. Select the account(s) you want to group from
the Account and Description columns displayed
on the left. Drag the account(s) to the Group or
Sub-Group folders on the right. Continue this
process until all the accounts are grouped.

Note: Use the Account and Description
Filters fields to show only the accounts you
want to group. Use a question mark (?) as a
place holder and an asterisk (*) as a
wildcard. For example, to display all
accounts with 5 as the second character,
such as 1500-01-1000, type ?5*.

8. Click the Options button to administer your
Grouping Lists. You can create new groups,
delete or rename existing groups, and export
groups from this window. You can also access
standard Tax Line Grouping lists by clicking
Import.

9. Click Close when you are finished
administering your Grouping Lists.

10. Click Close when you are finished grouping
accounts.
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Setting up Funds

You can add, edit, or delete fund types, fund
subtypes, and funds to define the fund hierarchy, as
well as assign accounts to funds for reporting
purposes. In addition, a mask for use during Paste TB
Import for the fund portion of the account number
can be defined, if applicable, in the Funds Setup
dialog.

In the trial balance, select Funds Setup from the
Groups & Funds group of the Engagement ribbon.

The Funds Setup dialog displays. Add, edit or delete
the fund hierarchy data for the selected fund trial
balance using the tabs on the dialog.

Fund Mask. Use this tab to indicate if the
account number structure includes the fund
index for the account. The fund mask is used
during Paste TB Import to assign accounts to
funds.
Fund Types. Use this tab to create and
organize fund types. Fund types are the top
level of the fund hierarchy when organizing
funds for reporting and analysis. At least one
fund type must exist for categorizing funds.
Fund Subtypes. Use this tab to create and
organize fund subtypes. Fund subtypes are the
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level below fund type of the fund hierarchy
when organizing funds for reporting and
analysis. Fund subtypes are optional.
Funds. Use this tab to assign funds to a type
and subtype. Funds are the lowest level of the
fund hierarchy and are required to report on
and analyze accounts by fund.
Accounts. Use this tab to assign accounts to a
fund. Accounts must be assigned to a fund to
accurately report on and analyze the balance
of each fund.

Journal Entries

1. Select Journal Entry Summary from the Trial
Balance menu in the Binder window.

2. From the Trial Balance drop-down list, select
the trial balance to which to post the journal
entry.

3. In the Type pane, select the type of entry.
4. Click New to open the Journal Entry Detail

window.
5. Enter the journal entry number, description and

W/P reference in the appropriate fields.
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6. Select the accounts for the entry by double-
clicking an account on the left-hand side.

Note: Click Add Account to create
accounts that are not in the Chart of
Accounts. Click Remove JE Line to
remove the selected account from the
journal entry field.

7. Enter the amounts in the cells.
8. Select one of the following:

Save and New to record another entry.
Save and Close to return to the Journal
Entry Summary screen.

Note: From the Journal Entry Summary screen,
you can reclassify any entry to another journal
entry type by dragging and dropping the journal
entry to the appropriate icon in the left pane.
Click Close when finished.
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Recording Transactions in Write-Up Trial
Balances

To record transactions in write up trial balances,
follow these steps:

1. Open the write up trial balance.
2. Click Write-Up Journal Entry on the toolbar.
3. From the Trial Balance drop-down menu, select

the trial balance you want to post transactions
to.

4. Select the journal to use to enter the
transactions.

5. Click New to start entering your transaction.
Enter the Date, Ref, Transaction, Account #,
Account Description, and Debit and Credit
amounts.

Note: Click Options for choices involving
dates, reference numbers, or account
numbers.

6. Click Close to finish entering transactions.

Note: See Advanced Trial Balance Functions on
page 76 for instructions on how to create write
up trial balances.
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Reports

The following types of reports can be created by
Engagement:

Journal Entry (JE)
Fund Journal Entry
Trial Balance (TB)
Fund Trial Balance
Consolidated
Write Up

JE Reports

1. Open the trial balance.
2. Select Create Reports > Journal Entry

Reports from the Engagement menu.
3. Select the trial balance from the Trial Balance

list.
4. Place a check in the box for each type of JE

Report to create.
5. Click OK. The reports are placed in the Unfiled

Workpapers tab in your Engagement binder.
From there, you can rename the files and then
drag them to the appropriate tabs.
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Fund JE Reports

1. Open the trial balance.
2. Select select Create > Fund Journal Entry

Reports from the Engagement menu.
3. Select the trial balance from the Fund trial

balance list.
4. Check the box for each type of journal entry

you want to include in the report.
5. In the Fund report options section, choose from

the report sorting options available.
6. Select the fund types, fund subtypes and funds

in the tree control that you want to include in
the report.

7. Click OK. The report is generated as an Excel
workpaper and saved in the tab location
specified in the dialog.

TB Reports

1. Open the trial balance.
2. Click Create TB Report on the toolbar.
3. Select the trial balance from the Trial Balance

list.
4. Select the Grouping List to generate the report

from.
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5. Choose one of the following in the Account
Groups section:

Include selected. Includes only the
groups you place checkmarks by.
Include current and future. Includes
all groups that are currently in the
selected grouping list and automatically
adds any groups that are created in the
future.

Note: If you select Include current and
future, you may select the Classified
Report option to create a report that is
organized by the account and ratio
classifications assigned to the groups and
sub-groups.

6. Choose the appropriate radio button in the
Report Type field to choose the level of detail:

Summary – Groups. Summarizes your
report at the Group level.
Summary – Sub-Groups. Summarizes
your report at the Sub-Group level.
Detail. Displays all charts of accounts
organized into the groups and
sub-groups. If you check the Combine
Groups box, the information generates
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in one report. Otherwise, a separate
report is generated for each selected
group.

7. Enter a name in the Report Name Guide field.
8. Select from the following options:

Hide empty groups and sub-groups
and Hide accounts with zero balances.
Hides indicated items.
Print as Black and White. Sets the
default print settings to black and white.
Show W/P Ref Columns. Displays
workpaper references created in the
trial balance.
Include sum of account groups.
Subtotals the groups within a classified
report.
Include net income. Displays net
income amount on an unclassified
report. Note that net income will always
be included on classified reports.

9. Click Format to select which trial balance
columns you want to include in the report.

Drag columns from left to right to add
them.
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Drag columns from right to left to
remove them.
Add Variance columns as needed.

10. Click OK to save your column setup.
11. Click OK to create the reports. The reports are

stored in the Unfiled Workpapers tab in your
Engagement binder.

Notes:

See Appendix on page 109 for sample TB Report
Settings.
To modify the report setup after you create it,
open the report and then from the Engagement
menu, select Properties. Make your changes
as noted in the steps above and click OK to
save them.

Fund TB Reports

1. Open the trial balance.
2. Select select Create> Fund TB Reports from

the Engagement menu.
3. Select the trial balance from the Fund trial

balance list.
4. Check the boxes next to the group or groups for

which you want to create a report.
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5. Use the other tabs on the dialog to select
options for the fund trial balance report.

6. Click OK. The report is generated as an Excel
workpaper and saved in the tab location
specified in the dialog.

Consolidated Reports

1. Open the consolidated trial balance.
2. Select Create Reports > Consolidated

Reports from the Engagement menu.
3. Select the report options, as desired. These

options are the same as with a regular trial
balance.

4. Click OK to create the report. The report will
be stored in the Unfiled Workpapers tab of your
Engagement binder.

Note: See Advanced Trial Balance Functions on
page 76 for instructions on how to create
consolidated trial balances.
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Write-Up Reports

Engagement provides the following three write up
reports to display the information entered in write
up journals:

Write-Up Detail. This report will show the
detail of the entries in the selected journal.
The columns in the report are the same as in
the journal.
G/L Current and G/L YTD. These two reports
show the accounts in the trial balance, their
beginning balance, transaction amounts, and
ending balance for the current or YTD period,
whichever you select.

Creating the Write-Up Detail Report

1. Select Create Reports > Write-Up Reports >
Write-Up Detail Report from the Engagement
menu.

2. Select the trial balance from the drop-down
list.

3. Check the boxes for the specific write up
journals you want to create.

4. Click OK to create the report. The report is
stored in the Unfiled Workpapers tab in your
Engagement binder.
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Creating G/L Current and G/L YTD Reports

1. Select Create Reports > Write-Up Report
from the Engagement menu.

2. Select G/L Current Report or G/L YTD
Report. The Select Journal Entry dialog
displays.

Important! If you select G/L YTD Report
for a non-annual binder, the Select
Journal Entry dialog does not display. The
report is created with only write up
journal entries.

3. Select the types of journal entries to include in
the report. By default, Client Journal Entries
and Adjusting Journal Entries are already
selected.

4. Click OK. The report is stored in the Unfiled
Workpapers tab of your Engagement binder.

Note: See Advanced Trial Balance Functions on
page 76 for instructions on how to create write up
trial balances.
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Linking to the Trial Balance

Name and Date Links

Name and date links enable you to insert information
about the client, firm, binder, workpaper, or dates
related to the engagement.

Name information comes from the Properties
window of the client, firm, binder, or
workpaper.
Date links are calculated from the Periods and
Dates tabs in the Binder Properties window.

To insert name or date functions, do the following:

1. Open the workpaper.
2. Do one of the following:

In Excel, click the cell where you want
to insert the link.
In Word, either place your cursor where
you want to insert the link or highlight
the text that you want to replace with a
Name or Date link.

3. Click Name Functions or Date Functions on
the Engagement toolbar. A menu of name or
date functions displays.
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4. Select the name or date option you want to
insert.

Linking Trial Balance Data

This section explains the two methods for linking
trial balance data.

Copying and Pasting TB Links

1. Open both the trial balance and the Excel or
Word workpaper you want to link.

2. Activate the trial balance in Excel by selecting
it from the Window menu, and select the trial
balance cell(s) you want to link to the
workpaper. Click Copy TB Link.

3. Switch to the workpaper you want to paste the
link(s) to.

4. Select the area you want to paste the links
into.

5. Do one of the following when pasting a link
into one of the areas listed below:

Excel spreadsheet. Select the cell or
the first cell in the range if you are
pasting multiple cells and click Paste TB
Link.
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Word Table. Highlight the entire table
cell and click Paste TB Link.
Word Paragraph. Insert the cursor
where you want the data to appear or
select the text to replace, and then
click Paste TB Link.

6. Select the options you want to use from the
window that appears.

7. Click OK when finished setting the paste
options.

Inserting TB Link

1. Open the Excel or Word workpaper.
2. Place the cursor where you want to insert the

TB Link.
3. Click Insert TB Link on the toolbar.
4. Build a formula using the six parameters: Trial

Balance, Account Grouping, Type, Period,
Balance Type, and Account/Index #. When a
fund trial balance is selected you can also
optionally select a Fund Type, Fund Subtype or
Fund Index.

5. If you want to round the amounts used in the
formula, check the Round box and select the
number of places after the decimal to round to.
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6. Select Sign options in Excel or Word, and
select Negative style, Numeric style, and
Zero style in Word.

7. Click Insert once you have selected the
parameters for the formula. The formula will
appear in the TB Link Formula box.

8. A plus sign (+) appears at the end of the
formula. You can add to the existing formula
by selecting the appropriate parameters again
and clicking Insert.

9. Click Paste to insert the TB Link into the
workpaper.

Analyzing a TB Link Formula

To view a TB Link in Excel, click on a cell
containing the TB Link. The formula will appear in
the formula bar.

In Word, click Toggle Field Codes or View Field
Codes. A Word formula has several formatting
parameters, but within this formula you will see the
same formula noted in Excel.

TBLink(“Trial Balance”,"ADJ[5]","4110","15","1")

Trial Balance represents the name you gave
the trial balance database you linked from.
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ADJ[5] represents the trial balance column you
linked from. ADJ shows the balance type
abbreviation you defined in the Trial Balance
Column Setup window. [5] is the balance type
period ID assigned by Engagement.
4110 is based on the type listed for the last
parameter in the formula. The number will
either be the group index, sub-group index,
account type abbreviation, account class
abbreviation, ratio class abbreviation or the
account number.
15 represents the grouping list ID found in the
Grouping List Options dialog which is accessed
through the Account Groupings dialog.
1 represents the type of trial balance link that
is being created; it indicates the level of detail
needed.

Options include:
3 = Account Detail
2 = Sub-Group Summary
1 = Group Summary
0 = Ratio Class
-1 = Account Class
-2 = Account Type
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Note: When linking to an account number, group
or subgroup index, “ADJ[5]” will instead be
“Account[Account].” When linking to an account,
group or sub-group description, “ADJ[5]” will
instead be “Description[Description].”

Syntax with Fund Parameters

In a fund trial balance, you can link to fund
information within the trial balance. Links can be
created at the level of Fund Type, Fund Subtype or
Fund. When including fund information in the trial
balance link, the Fund Type Index, Fund Subtype
Index or Fund Index will be used.

Drill Down to Trial Balance Accounts

Once TB Links are created in the Excel or Word
workpapers, you can drill down to the accounts that
make up the dollar amounts calculated in the linked
formula.

1. Open the Excel or Word workpaper.
2. Do one of the following:

In Excel, click the cell with the linked
formula.
In Word, highlight the linked field.

75



Using Trial Balance Functions

3. Click Drill Down TB Link.
4. Click Close when finished.

Advanced Trial Balance Functions

Consolidating Trial Balances

Consolidations occur at the trial balance level within
one Engagement binder. You will set up a trial
balance for each subsidiary and then consolidate
them into a consolidated trial balance.

To create a consolidated trial balance, do the
following:

1. Select the tab you want to insert the trial
balance into from the Binder window.

2. Click New Trial Balance on the Binder
window.

3. Click the Consolidated tab.
4. Select the Consolidated Trial Balance – 2

Year template.
5. Click OK.
6. Complete the Index # and Name fields in the

Workpaper Properties dialog.
7. Click OK to create the trial balance.
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Consolidating Subsidiary Trial Balances

You can consolidate subsidiary trial balances into a
blank consolidated trial balance. To consolidate
subsidiary trial balances, do the following:

1. Open the consolidated trial balance.
2. Click Consolidate on the Engagement toolbar.

3. From the Consolidated Trial Balance drop-down
list, select the trial balance you want to hold
the consolidated information.

4. Click Add to add a subsidiary trial balance.
5. Select the trial balance from the Trial Balance

list.
6. Type the abbreviation you want for the column

heading.
7. Select a grouping from the Grouping List drop-

down.
8. Check the Overriding List box if you want to

take precedence over the trial balance(s) when
there are conflicts with the description of the
grouping basis or grouping codes.

9. Select the balance type to consolidate in the
Balance field.

10. To add more subsidiaries, click Add and repeat
steps 5 through 9.
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11. Select the consolidation basis based on groups,
sub-groups or account detail.

12. Select how you would like numbers to be
rounded from the Rounding drop-down list.

13. Select the Number of Prior Periods you want
to gather during consolidation.

14. Click OK to consolidate.

Note: See Reports on page 62 for instructions on
how to create consolidated reports. See Journal
Entries on page 59 for instructions on eliminating
journal entries.

Fund Trial Balances

Fund trial balances allow you to store and manage
financial data by funds.

1. Select the tab you want to insert the trial
balance into from the Binder window.

2. Click New Trial Balance on the toolbar.

3. Click the Fund tab.
4. Select the desired template.
5. Click OK to display the Workpaper Properties

dialog.
6. Complete the Index # and Name fields.
7. Click OK to create the Fund trial balance.
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Write-Up Trial Balances

Write-Up trial balances allow you to enter
transactions into write up journals or book client
journal entries. To create a write up trial balance,
follow these steps:

1. Select the tab you want to insert the trial
balance into from the Binder window.

2. Click New Trial Balance on the toolbar.

3. Click the Write-Up tab.
4. Select the Write-Up template.
5. Click OK to display the Workpaper Properties

dialog.
6. Complete the Index # and Name fields.
7. Click OK to create the write up trial balance.

If you prefer to book standard two-sided entries as
Client Journal Entries, instead of the transaction
journals, see Journal Entries on page 59. You can
choose one of the two methods for entering Client
Journal Entries. Either method will display in the CJE
column of the write up trial balance.

Note: See Reports on page 62 for information on
creating write up reports.
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Exporting to Tax Software

To export your trial balance data to a supported tax
software package, you must have grouped your
accounts to one of the Account Grouping Lists. See
Account Groupings on page 55 for instructions on
grouping accounts.

Follow these steps to export the data:

1. Click Tax Software Interface from the Binder
window.

2. Select the vendor you will be exporting to from
the Tax Software drop-down list.

3. Verify the appropriate tax Account Grouping
List is selected in the Grouping drop-down list.

4. In Configuration information, enter the Tax
year, Grouping, Balance, and Employer ID #.

5. Select the balance you want to export from the
Balance drop-down list. The Export Prior Year
checkbox is always checked to export that
information.

Note: You must control the import of prior
year information in the tax program.

6. In Export information, Engagement provides
default paths and names for the information
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you need to export to the respective tax
vendor; however, you may need to browse to
the appropriate directory by clicking Browse.

7. Click OK after you have set all the options. A
report lists any ungrouped accounts. If any are
listed you will need to go back to the Account
Grouping window to make your corrections and
re-export the data.

Tip: When customizing a tax Account Grouping
List, you can add sub-groups to groups that
support detail schedules in your tax software.
The sub-group descriptions will appear as the
description on the detail schedule.

You cannot add groups to a tax Account
Grouping List, as they will not export to your tax
software. Also, you can choose which groups or
sub-groups should be exported by selecting the
Send to Tax option in the group or sub-group
properties.
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Sharing Workpapers

Only the Current Editor (in a non-shared file room)
or the Live Editor (in a shared file room) can make
changes to a workpaper. Other team members will
have a read-only copy of the workpaper.

When you check unassigned workpapers out of the
central file room, you become the Current Editor.
You remain the Current Editor until you check in the
workpaper to the central file room or assign the
workpaper to another team member.

There are five methods you can use to share
workpapers:

Shared Local File Room
Synchronize Binder
Synchronize Selected Workpapers
Express Synchronization
Binder Packages

When the Engagement team is attached to an office
network, the central file room will be utilized to
share and distribute binders. When you log in to
Engagement from the Office, the program will
display the central file rooms that have been set up.

When the Engagement team is attached to a peer-
to-peer network in the field, they will be able to
share and distribute binders directly with each other.
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When you log in to Engagement from the Field, each
staff member assigned to binders in your local file
room displays.

When you are not on a network or you need to
email a binder to a staff member, you do not
synchronize to the central file room or to another
staff member’s local file room. See Binder Packages
on page 88 for further details.

Shared File Rooms

Shared local file rooms allow multiple Engagement
users to work directly with workpapers in the same
binder without synchronizing with a central file
room, checking out workpapers, or assigning
workpapers.

To work with shared file rooms, the option must be
enabled for your firm in Administrator, and you must
belong to a staff group that allows sharing of local
file rooms.

A Host selects to share his or her local file room, and
then other users can log in to the shared file room.
Users can open any workpaper in the Host’s file
room if the Host is the Current Editor.
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Sharing a Local File Room

To share a file room, do the following:

1. Log in to Engagement as either Office or Field.
2. Right-click within the file room frame.
3. Select Share File Room.

To stop sharing a file room, do the following:

1. Log in to Engagement as either Office or Field.
2. Right-click within the file room frame.
3. Select Stop Sharing File Room.

Editing Workpapers in a Shared File Room

Working with workpapers in a shared file room is
similar to working in your own local file room. When
you open a binder in the Host’s local file room, the
Binder View displays.

The Live Editor column displays the current status of
each workpaper. The following statuses are
displayed:

(User Name). The user whose name displays is
currently the Live Editor of the workpaper. You
can view a read-only copy of the workpaper
until the Live Editor closes it.
<Available>. The local file room’s Host is the
Current Editor of the workpaper, and no other
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users are currently working on the workpaper.
These workpapers are available for you to open
and edit.
<Unavailable>. The Host is not Current Editor
of the workpaper.

Click on any workpaper with <Available> displayed
in the Live Editor column to edit the workpaper.
Close the workpaper when you finish editing it.
There is no synchronization or check-in required.

Synchronize Binder

Use Synchronize Binder if you want to update
changes made to workpapers with other staff
members.

1. Select the binder in the File Room window.
2. Click Synchronize Binder on the toolbar.
3. Click Next on the Synchronize Binder Wizard

Welcome screen.
4. Select the Staff or Buddy List member you

want to synchronize with. If you are
synchronizing the binder in the field
environment with a staff member whose
computer is not listed in the Existing Locations
drop-down list, browse to the appropriate path
in the Alternate Locations field, then click
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Next. The Synchronize Entire Binder or
Selected Workpapers dialog displays.

5. Select whether to synchronize the entire binder
including all workpapers, or to synchronize
only workpapers you select.

6. Click Next. If you have current editor rights for
any workpaper, the Assign Workpapers dialog
appears. Select the workpapers you would like
to assign to the staff member’s local file room.
When you assign the workpapers, you no longer
have current editor rights to these workpapers
in your local file room.

7. Click Next. If you are synchronizing only
selected workpapers, and new workpapers exist
in either your local file room or the remote file
room, the Synchronize Workpaper from your
LOCAL File Room or Synchronize Workpaper
from REMOTE File Room dialog displays, as
appropriate. Select the workpapers to
synchronize.

8. Click Next. The Completing the
Synchronization Wizard dialog displays.

9. Click Synchronize.
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Synchronize Individual Workpapers

When logged in from the field, you can synchronize
selected workpapers with other staff members or a
staff member in your Buddy List.

Note: Before using the Synchronization Binder
Wizard or Express Synchronization, you must close
all workpapers within the binder. A closed binder
selected for synchronization can be opened.

1. Open the binder containing the workpapers to
synchronize.

2. Select the workpapers to synchronize. If you
are synchronizing multiple workpapers, press
Shift to select contiguous workpapers, or press
Ctrl to select non-contiguous workpapers.

3. Right-click the selected workpapers and select
Synchronize Workpaper, or select
Workpaper > Synchronize Workpaper. The
Synchronize Target dialog displays.

4. Select the target to synchronize with.
5. Click OK. The Synchronize Workpaper dialog

displays a list of selected workpapers that are
available for synchronization.

6. Click Synchronize. The Synchronization Job
Queue dialog displays the progress of the
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synchronization. You can click Hide to close
the dialog.

Express Synchronization

Express Synchronization automatically synchronizes
changes from the local file room to the central file
room, and from the central file room to the local
file room, without opening the Synchronize Binder
Wizard. You do not have the option to check
workpapers in or out.

To perform an express synchronization, do the
following:

1. Select the binder in the File Room window.
2. Click Express Synchronization on the toolbar.

Binder Packages

Creating a Binder Package

1. From the File Room, select the binder you want
to package.

2. Click Create Binder Package from the File
Room window.

3. Select the workpapers to include in the binder
package.

88



Sharing Workpapers

4. Select how you want to distribute the binder
package.

To save the binder package as a file,
select the Save package to a file
option. Verify the path and file name of
the binder file.
To send the binder package as an email
attachment, select Send package via
email.

5. Click OK.

Receiving a Binder Package

After a binder package has been created, other
Engagement staff members can receive the file. To
receive a binder package, follow these steps:

1. Click Receive Binder Package from the File
Room window.

Note: If you are receiving a binder
package via email and you use Microsoft
Outlook, select Engagement > Receive
Binder Package in Outlook.

2. Browse to the binder package file (with an AZP
extension) to receive.
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3. When you receive a binder, one of two events
will occur:

If you do not have this binder,
Engagement will find the client folder
and attempt to insert the binder into the
client folder. If the client folder does
not exist, Engagement will create it.
If you have this binder, Engagement will
check the binder you are receiving and
the binder you already have to
determine if there are any conflicts. If
different Current Editors of the same
workpaper exist and the copy of the
original Current Editor has been
modified, then you will be warned of a
conflict when you open the binder.
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Note: During synchronization, conflicts between
the binder in the local file room and the binder in
the central file room cause the Synchronization
Conflicts dialog to appear. These conflicts arise
when each copy has a different Current Editor and
the copy of the original Current Editor has been
modified, which also includes changes to the
properties of the workpaper. To resolve the
conflict, specify whether the Local copy or the
Remote (remote local file room, central file
room, or binder package) copy of the binder
should "win," becoming the only file to remain
between the two. You can view the details of the
conflict by clicking View Details. Click OK to
continue.
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Workpaper Notes

There are three types of workpaper review notes you
can use to electronically communicate during an
engagement:

Open Item
Team Note
Note for Next Period

You can use the Notes pane in the Binder window or
the Notes Summary View to keep track of which
notes require response, clearing, or deletion.

Creating a Workpaper or Workpaper Tab Note

1. Select the workpaper or workpaper tab from
the Binder window.

2. Click Create Workpaper Note.
3. Select the type of note from the drop-down

list.
4. To address the note to an individual team

member, uncheck the All Binder Staff
checkbox and select a specific staff member.

5. Enter the note’s subject in the Subject field.
6. Enter the note’s text in the Note field.
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7. Click OK to save your note. The note
information appears in the Notes pane.

Responding to, Clearing, or Deleting a Note

To clear, delete, or respond to a workpaper or
workpaper tab note, do the following:

1. Click the Notes Summary View tab in the
Binder window.

2. Right-click the note and select one of the
following:

Respond to Note allows you to reply.
Enter a response. Click OK to save your
text.
Clear Note crosses out content and any
replies. A record of the note remains in
the Binder View and Notes Summary
View. The status changes to cleared.
Delete Note erases the note.
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Workpaper Sign Off

You can sign off workpapers as the Preparer,
Reviewer, and/or 2nd Reviewer. A workpaper can
have multiple preparers, reviewers, and second-level
reviewers on workpapers.

To sign off a workpaper, do the following:

1. Select the workpaper in the Binder window.
2. Click Sign Off Workpaper Properties.
3. Select your name from the Current User drop-

down menu.
4. The Date will default to today’s date. Select a

different date if necessary.
5. Add or update your sign off signature by

clicking the plus sign (+) in the Preparer or
one of the Reviewer fields. Click the minus
sign (-) to remove your sign off.

6. Click OK to save your changes.

In addition, you can sign-off on workpapers using the
icons on the Binder Index toolbar. You can also
right-click the workpaper and select any of the Sign
Off options from the menu.

You can manage the sign-off status of Engagement
workpapers by selecting the Sign Off Summary View
tab.
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Lock/Unlock Workpapers

After the workpaper has been reviewed and signed
off, you may want to lock the workpaper. A
workpaper that is locked is read-only. Links will
continue to update provided they are not frozen.

To lock or unlock a workpaper, follow these steps:

1. Select the workpaper you want to lock or
unlock from the Binder window.

2. Click the Lock Workpaper or Unlock
Workpaper button. When the workpaper is
locked, the Lock symbol appears. The
workpaper is now a read-only file.

Freeze/Unfreeze Workpapers

There may be situations where you want to freeze a
workpaper. Engagement links such as name and date
links and TB links in a workpaper that is frozen are
not updated if changes are made to the trial
balance.

To freeze or unfreeze a workpaper, follow these
steps:

1. Select the workpaper in the Binder window.

2. Click Freeze Engagement Links, represented
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by a broken chain, or Unfreeze Engagement
Links, represented by a solid chain.

Note: If you publish a workpaper with frozen
links, the published workpaper will contain the
values of the links when frozen.

Tickmarks

Using the Tickmark Definition List

The tickmark definition list contains the tickmark
symbols (images) and descriptions.

To use the tickmark definition list, follow these
steps:

1. Open a report or workpaper in Excel, Word, or
Adobe Acrobat.

2. Select Engagement > Tickmark > Tickmark
Definition.

3. To add your own tickmarks to this list, click
Add.

4. Enter the tickmark name and description.
Browse to a 16-color, 16 x 16 pixel bitmap
picture and click Open. You are returned to
the Tickmark Definition dialog, and your image
appears in the left-hand column.

5. Click Close.
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Note: To delete a tickmark, highlight the
tickmark and click Delete.

Inserting Tickmarks

To insert a tickmark symbol in an Excel, Word, or
Adobe Reader/Acrobat 9 or earlier, do the following:

1. Open an Excel, Word, or Adobe PDF workpaper.
2. Click the Tickmarks button.
3. Do one of the following:

If you are using Microsoft Word or Excel,
click where you want to insert the
tickmark, and then click the tickmark
symbol in the Tickmark Toolbar.
If you are using Adobe, click the
tickmark symbol in the Tickmark
Toolbar, and then click where you want
the tickmark to be displayed.

The tickmark symbol displays in the designated
spot. (In Excel, the tickmark appears on top of
the cell.)

To insert a tickmark symbol using Adobe
Reader/Acrobat 10, do the following:

1. Open the workpaper in Adobe Reader 10 or
Acrobat 10.
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2. Click Tools on the Quick Tools bar. The Tools
pane displays on the right.

3. Click Plug-in Engagement Tickmark on the
Tools pane. The Engagement tickmarks display.

4. Click the tickmark symbol in the Tools pane,
and then click where you want the tickmark to
be displayed in the PDF.

Tip: You can right-click any tickmark to
add it to the Quick Tools bar.

Workpaper Reference Links

Inserting Workpaper Reference Links

1. Open an Excel, Word, or Adobe Acrobat
workpaper.

2. Follow these steps if you are working with
Excel or Word:

a. Click in the cell (Excel) or place the
cursor in the document (Word) where
you want to insert the workpaper
reference link.

b. Click Insert WP Reference.
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Follow these steps if you are working with
Acrobat:

a. Click Insert WP Reference.
b. Click the location in the workpaper

where you want the workpaper
reference to be placed.

3. Select the workpaper you want to reference.
4. Click Insert.
5. Click Close.

Opening Referenced Workpapers

To open a referenced workpaper, do the following:

1. Open the Excel, Word, or Adobe Acrobat
workpaper.

2. Click in the cell containing the reference
(Excel) or highlight the workpaper reference
(Word or Acrobat) you want to open.

3. Click Open WP Reference.

Publishing Workpapers

If you want to send someone an electronic copy of a
Word or Excel workpaper, you should publish the
workpaper. A published workpaper is a copy of a
workpaper in which the formulas (such as, trial
balance links) have been converted to values. This
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allows you to share the workpaper with people who
do not have access to the trial balance database.

To publish a workpaper, follow these steps:

1. Select the workpaper you want to publish in the
Binder window.

2. Click Publish Workpaper.

A copy of the workpaper is filed in the Published
Workpapers tab in the Binder window. The original
name of the workpaper now has - Published
appended to the end. All of the formulas, such as
dates, names, and amounts, have been converted to
values. This published workpaper will not be updated
because the formulas no longer exist.
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Other C ommon Features

Creating Templates

This section includes procedures for creating the
following templates:

Trial Balance
Workpaper
Account Groupings
Print Groups
Tickmarks
TB Links

Trial Balance Templates

If there is a trial balance that has a format you use
frequently, you can save it as a template.

Note: Trial balance templates created with a
version of Engagement prior to 6.0 must be
converted to a format supported by Microsoft SQL
Server database. To do this, select File >
Convert Trial Balance Templates in the
ProSystem fx Engagement File Room.

101



Other Common Features

Follow these steps to save a trial balance as a
template:

1. Open the trial balance.
2. Select Engagement > Properties.
3. Uncheck Hide zero balance groups and sub-

groups and Hide zero balance accounts. The
numbers and groups will now show up on the
trial balance when it is created from this
template.

4. Click OK.
5. Close the trial balance.
6. Right-click the trial balance in the Binder

window and select Save as Template.
7. Select the template folder where you will save

the template.
8. Type the file name for the template.
9. Check the Clear chart of accounts box if you

do not want to save the account numbers and
descriptions in the template.

10. Check the Save journal entries box to save
the journal entries (accounts and amounts) in
the template.

11. Click Save.
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Workpaper Templates

If there is a workpaper format you use frequently,
you can save it as a template. Follow these steps to
save a workpaper as a template:

1. Select the workpaper in the Binder window.
2. Right-click the workpaper you want to make

into a template and select Save As Template.
3. Keep the default path and name, or browse for

the path and type a name for the template and
click Save.

Note: Knowledge Coach workpapers cannot be
saved as templates. Instead, you can copy
Knowledge Coach workpapers from one binder to
another.

Account Grouping Templates

To use an account grouping in another trial balance,
you can follow these steps to save an account
grouping as a template:

1. Select Trial Balance > Account Groupings
from the Binder window.

2. In the Trial Balance and Grouping List field,
click the Options button. The Grouping List
Options dialog displays.
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3. Select a grouping from the grouping lists
shown.

4. Click Export.
5. Browse for the path and enter a file name.
6. Click Save to create the template, and click

Close to close the Grouping List Options
dialog.

Print Group Templates

To print a group of workpapers and save a print
group as a template, follow these steps:

1. Select File > Print Group in the Binder
window. The Print Group dialog displays.

2. Select the workpapers in the print group from
the left side.

3. Click Save Print Group.
4. Enter a name in the File name field.
5. Click Save.

Tickmark Templates

To share tickmarks with other team members and
save them as templates, follow these steps:

1. Open an Excel, Word, or Adobe Acrobat
workpaper.
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2. Select Engagement > Tickmark > Tickmark
Definition.

3. Click Export.
4. Browse for the path and click Save.

For further information, see Using the Tickmark
Definition List on page 96.

Saving TB Link Formulas

To save TB Link formulas (e.g., complex ratios) as
templates for other workpapers, follow these steps:

1. Build a TB Link formula using the Insert TB
Link function. See Linking to the Trial Balance
on page 70 for further details.

2. In the Insert TB Link window, click Save.
3. Type a name and description for your saved TB

Link formula.
4. Click Close.

Renaming Items

Throughout the system, you can rename items by
selecting the items you want to rename and clicking
the Properties toolbar button. Make your changes
and click OK to save them.
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Deleting Items

Warning! When a Knowledge Coach workpaper
is deleted, it is removed permanently. It is not
sent to the Trash folder and cannot be restored.

To delete items in the file room, select the item(s)
to delete and press Delete. These items are
permanently deleted.

To delete items in the Binder window, select the
item(s) to delete and press Delete. The items are
now in the Trash.

Notes:

To restore an item deleted from the Binder
Window, right-click the Trash icon and select
Restore All, or right-click on individual
workpapers and select Restore.
Depending on the settings in Administrator,
upon closing a binder Engagement will keep the
items in the trash, prompt you to delete the
items in the trash, or automatically delete the
items in the trash.
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Getting More Information

For more detailed information on these functions,
and to better understand their underlying concepts,
you can refer to the following sources:

Tip of the Day
User Guide (see Help menu in Engagement)
Online Help (see Help menu in Engagement)
Technical Support at
https://support.cch.com/engagement

CCH, a Part of Wolters Kluwer, provides hands-on,
detailed training on all the information contained in
this guide. Consulting services are also available to
assist you in the development of procedures and
templates, so that you may fully experience the
benefits of ProSystem fx Engagement. For more
information about Training & Consulting Services,
contact our Customer Training department at 1-800-
739-9998.

Contacting ProSystem fx Engagement

Technical Support

Hours: 6:00 a.m. to 5:00 p.m. U.S. Pacific Time,
Monday through Friday

Phone: 1-800-739-9998
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Product Updates, FAQs and more

Visit: https://support.cch.com/engagement

Training & Consulting

Attention: Engagement Training Coordinator

CCH, a Wolters Kluwer business

Customer Training Department - M/S 21

20101 Hamilton Ave. Suite 200 Torrance, CA 90502

Email: training_coordinator@cch.com
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TB Report Sample Settings

The following table includes TB Report settings for
common reports used in an engagement. You can
also customize any report to show the information
you need.

Report
Name

Account
Group –
radio
button

Report
Type

Format –
columns
included

Leadsheet
(s)

Include
selected
(Check
boxes as
needed)

Detail

PY-Final
CY-
Unadjusted
CY-AJE
CY-Final

Working
Trial
Balance

Include
current
and future
(Classified
report)

Detail
Combine
Groups

PY-Final
CY-
Unadjusted
CY-AJE
CY-Final
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Report
Name

Account
Group –
radio
button

Report
Type

Format –
columns
included

Preliminary
Analytical
Review

Include
current
and future

Summary
by
Group or
Sub-
group
(Include
Net
Income)

PY-Final
CY-
Unadjusted
$-Variance
%-Variance

Final
Analytical
Review

Include
current
and future

Summary
by
Group or
Sub-
group
(Include
Net
Income)

PY-Final
CY-Final
$-Variance
%-Variance
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Report
Name

Account
Group –
radio
button

Report
Type

Format –
columns
included

Budget-to-
Actual

Include
selected
(Click
Select All)

Detail

CY-Budget
CY-Final
$-Variance
%-Variance

Book-to-
Tax

Include
current
and future
(Classified
report)

Detail
Combine
Groups

CY-
Adjusted
CY-FTJE
CY-Tax
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